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Overview
System Diagnostics enables System Administrators to:

 l Monitor and diagnose overall environment performance and task health.

 l Examine application metrics and application data volumes. 

System Diagnostics helps to assure that the OneStream environment and applications 

are properly sized and efficiently configured.

System Diagnostics provides:

 l Detailed environment snapshot analysis across application and database servers.

 l Detailed application snapshot analysis of key metrics and data volumes.

 l Live monitoring across application and database servers.

 l Detailed task analysis including task concurrency, statistics, and counts.

IMPORTANT: Access to System Diagnostics is limited to users with the System 

Administrator security role. This should be strictly enforced because of the 

accessibility to application information and controls.
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Setup and Installation
System Diagnostics now comes preinstalled in your OneStream environment. System 

Diagnostics can be installed within an existing OneStream application, yet it enables you 

to analyze performance of all applications in a given environment. See Install System 

Diagnostics for details.

This section contains important details related to the planning, configuring, and 

installation of your solution. Before you install the solution, familiarize yourself with these 

details.
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Dependencies

Component Description

OneStream 

8.0.0 or later

Minimum OneStream Platform version required to install this 

version of System Diagnostics.
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Select the System Diagnostics Development 
Location
Before installation, decide whether to build the solution directly in the Production 

OneStream application or in a separate Development OneStream application. This 

section provides some key considerations for each option.

Production OneStream Application: The primary advantage of building the solution in 

a Production application is that you will not have to migrate the resulting work from a 

Development application. However, there are intrinsic risks when making design changes 

to an application used in a Production capacity and it is not advised.

NOTE: OneStream strongly recommends that you implement the solution in the 

Development environment with a fresh copy of the Production application before 

starting work.

Development OneStream Application: As a best practice, use the Development 

OneStream application to build the solution.
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Create the OneStream Development 
Application

 1. Ensure all the OneStream artifacts relating to System Diagnostics such as workflow 

profiles and entities are in the Production application.

 2. Copy your Production application to your Development environment and rename it. 

Use the development version for your System Diagnostics solution.
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Application Server Settings
You may need to edit the OneStream Application Server Configuration so users can 

create and change data in the additional database tables. If other OneStream Solutions 

(such as Specialty Planning) are already in the application, these adjustments may 

already exist.

Configure the OneStream Application Server
Be sure that the security group settings include the users who work on and set up the 

solution before proceeding.

NOTE: Group settings are applicable to all OneStream Solutions; it is important 

to keep the group names generic.

 1. Start the OneStream Server Configuration Utility as an Administrator.

 2. Click Open Application Server Configuration File > Database.

 3. Edit the following OneStream Database Server properties:

 l Access Group for Ancillary Tables: Select a group that includes those who will 

access records.

 l Can Create Ancillary Tables: True

 l Can Edit Ancillary Table Data: True

 l Maintenance Group for Ancillary Tables: Select a group to edit and maintain 

tables.
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 l Table Creation Group for Ancillary Tables: Select a group who can create 

tables.

 4. Restart Internet Information Server.

NOTE: The SQL Server account used for the OneStream application must have 

the View Server State Permission granted for System Diagnostics to access the 

SQL Server details.
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Install System Diagnostics
Check the Release Notes to determine if uninstalling only the user interface or a full 

uninstall of the solution is necessary and then read that section for instructions. If the 

Release Notes indicate that an overinstall is allowed, then continue with these 

instructions.

NOTE: In OneStream platform version 10.0, System Diagnostics comes 

preinstalled on the platform.

 1. Download the System Diagnostics solution from the OneStream Solution 

Exchange. The package is a zip file named OSD_PVx.x.x_SVzzz_

PackageContents.zip where x.x.x and zzz represent version numbers for 

OneStream and the solution. The PVx.x.x number (for example, 620) represents the 

minimum Platform Version (6.2.0) required to implement this solution version.

 2. In the OneStream Solution Exchange, go to OneStream Solutions and select the 

System Diagnostics tile.

 3. On the System Diagnostics Solution page, select the appropriate OneStream 

platform version from the Minimum Platform Version drop-down list.

 4. Select the most recent version from the Solution Version drop-down list and then 

click Download.
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 5. Log in to OneStream.

 6. On the Application tab, click Tools > Load/Extract.

 7. On the Load tab, locate the solution package using the Select File icons and click 

Open.

 8. When the solution’s file name appears, click Load.

 9. Click Close to complete the installation.
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Set Up System Diagnostics
The first time you run System Diagnostics, you are guided through the table setup 

process.

In OneStream, click Community Solution > Dashboards > System Diagnostics > 

System Diagnostics.

Create Tables

 1. Click Step 1: Setup Tables.

This step may be necessary when upgrading even if tables are already present. 

System Diagnostics does not drop any tables that already exist, but modifies table 

structures and add any new ones if necessary.

The following tables are created in the OneStream framework database:
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The Snapshot Automation scheduled task is created and can be edited in the Task 

Scheduler.
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NOTE: You should receive the message Solution Table Created if this is 

a new implementation of System Diagnostics.  If updating a previous 

release which includes changes to these tables, the message reads 

Solution Tables Upgraded.

See Also:

 l Task Scheduler

 l The Task Scheduler section in the Application Tools chapter of the Design 

and Reference Guide.

 2. Click Step 2: Launch Solution to open System Diagnostics.

After setting up the solution’s tables, a task is created in Task Scheduler that takes 

Application snapshots on the third Saturday of each month. You can change the task 

frequency and timing using the Task Scheduler.

NOTE: The Task Scheduler is currently only available when using the 

OneStream desktop application.

Package Contents
The Dashboard Maintenance Unit provides the user interface for System Diagnostics and 

includes the required dashboard groups, components, data adapters, parameters and 

files.

Business Rules
The following business rules are included:

OSD_HelperQueries
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Dashboard Data Set Business Rule. This rule provides query functions for collecting the 

activity and environment analysis information using a combination of SQL and 

programmatic data. 

OSD_SolutionHelper
Dashboard Extender Business Rule. This rule provides various functions for the System 

Diagnostics solution and the Dashboard user interface. 

OSD_ParamHelper
Dashboard XFBR String Business Rule. This rule provides conditional parameter 

processing functions that allow a parameter value to be interpreted and substituted with a 

different string.

OSD_ApplicationSnapshot
Extensibility Business Rule. This rule facilitates Application and Environment manual and 

Task Scheduled snapshots.

Data Management
The following Data Management Sequences and steps are used with their related 

Business Rules (as described above). The benefit of running these processes through a 

Data Management sequence is that they can run in the background while the user 

continues their work.

Data Management sequences are:

 l AppSnapshot_OSD

 l MonitorHealthTask_OSD

 l ReportPackage_OSD

 l SnapAutomation_OSD

Data Management steps are:
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 l AppSnapshot_OSD

 l CreateReports_OSD

 l MonitorHealthTask_OSD

 l SnapAutomation_OSD

 l TakeAppSnapshot_OSD

Data Management sequences used for application and environment snapshots, found in 

Task Scheduler for the System Diagnostic Automation task:

 l SnapAutomation_OSD
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Settings
The Settings page contains the Global Options tab in which key properties 

that guide administration are set as well as Uninstall tab, which provides 

solution uninstall options.

Global Options
The Global Options tab is used during the initial setup and configuration of System 

Diagnostics.

Number of Licensed Users: This setting is used for the estimation calculations in the 

Resource Validation Report. It is an estimation of how many users are expected to utilize 

OneStream. This setting is only visible if the user is on Azure and holds an unlimited 

number of user licenses.

NOTE: The maximum number of licensed users is 10,000.

User Per CPU Adjustment: This setting allows the ability to manually adjust the derived 

value of users per CPU. Users per CPU is used in the Environment Statistics calculations.
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Security Role: This setting allows you to select a security role. Users within the 

designated security role will have access to the solution.
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Uninstall
The Uninstall tab allows administrators to uninstall the System Diagnostics user interface 

or the entire solution. 

NOTE: If performed as part of an upgrade, any modifications made to the 

standard System Diagnostics objects are removed.

There are two uninstall options:

 l Uninstall UI removes System Diagnostics, including related dashboards and 

business rules, but leaves the database and related tables in place. Some Global 

Options will also be cleared because their values are stored in Parameters under 

Dashboards. 

Check the Release Notes to determine if this step is necessary. For some releases, 

this step should be performed before accepting a new version of System 

Diagnostics because some of the dashboards or other objects may have been 

modified.

 o Choose this option to accept a System Diagnostics update without removing 

the data tables.

 o The Release Notes indicate if an overinstall is supported.

 l Uninstall Full removes all the related data tables, all data, System Diagnostics 

dashboards, and related business rules.

 o Choose this option to completely remove System Diagnostics or to perform an 

upgrade that is so significant in its changes to the data tables that this method 

is required.
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NOTE: The System Diagnostics tables are stored on the Framework database. 

Removing these tables also removes all related System Diagnostics data for all 

applications using the same Framework.
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System Diagnostics Overview Page
Access the System Diagnostics Overview page by navigating to Community Solution > 

Dashboards > System Diagnostics > System Diagnostics.

Upon start up, you are directed to the overview page. Use this page to get an overview of 

your application and environment health. The overview page contains four condensed 

reports:

 l Database Usage: The pie chart displays how much storage is available and in use 

in an environment. Databases are sorted into used, unused, or allocated types.

NOTE: You will receive an error message if database usage data cannot be 

retrieved.

 l User Licenses: This shows licensed user data in two tiles, Active Licenses and 

Total Licenses.

 l Application Metrics: This displays the most recent changes (business rules, 

formulas, records, and more) in a snapshot of the current application. You can drill 

down into each metric for a detailed view of the change.

 l Daily logon activity

Click the title of a condensed report to navigate to the appropriate page in System 

Diagnostics.
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Click the Overview tab to return to the home page.

System Diagnostics Guide 20

System Diagnostics Overview Page



Environment Analysis
Use Environment Analysis to create environment snapshots by gathering information 

maintained by OneStream Environment Monitoring features. The environment snapshots 

provide details on application and database server status, available resources, and 

associated reports.

Create an Environment Snapshot
 l To create an environment snapshot for a given point in time click New Snapshot. 

The new snapshot displays in a list on the left side of the dashboard panel with any 

other snapshots that have been created.

 l To change a snapshot name, click the name value and relabel the snapshot. Click 

the save icon to maintain changes.

 l To delete a snapshot, select the snapshot name and then click on the minus icon.

NOTE: You must click the save icon after making any changes, including 

deleting a snapshot, for your environment to update.
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Application Servers
This section shows data specific to the application servers.
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Database Servers
This section shows data specific to the database servers.

Both application and database server reports display in a pivot grid, allowing you to sort 

and group records using the grid capabilities.
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Analyze Environment Snapshot Data
Select an environment snapshot and click Resources to view a breakdown of the data 

collected in the snapshot.

Environment Statistics Groups and Items
Environment statistics are grouped as follows:

 l User Concurrency: Shows concurrency statistics for user-related data including 

the number of licensed users, the concurrent logins, and the number of enabled and 

disabled user licenses.
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 l Gen-Stage Concurrency: Shows concurrency statistics for General-type or Stage-

type application servers.

 l Con-DataMgmt Concurrency: Shows concurrency statistics for Data 

Management-type or Consolidation-type application servers.

 l DB-Server Resources: Shows statistics for the database server in a stand-alone 

database server environment or the AzureSQL Elastic Pool for Azure Cloud 

environments.

A) User Concurrency

Use items in this group to gain insight into user activity and concurrency throughout your 

application.

Number of Licensed Users: Total number of licensed users permitted. This value can 

be changed in System Diagnostics settings.

Estimated Licensed Concurrent-Users: An estimated concurrency value based on the 

number of licensed users multiplied by the estimated concurrency.

Actual Concurrent Logins: Actual peak user concurrency for the past 30 days.

Actual Concurrent Users: Actual peak distinct user concurrency for the past 30 days.

Number of Enabled User Licenses: Total users that have the IsEnabled general 

setting in the system security settings set to True.

Number of Disabled User Licenses: Total users that have the IsEnabled general 

setting in the system security settings set to False.

B) Gen-Stage Concurrency

Use items in this group to gain insight into the user load on your general-type application 

servers.
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GenServer Users-Per-CPU: Maximum number of base users per central processing unit 

(CPU) minus the shared server deflator and large data unit deflator, plus any CPU 

adjustment per user.

The shared server deflator is used to account for CPU utilization between servers.

GenServer Supported-Users: Number of general-type application server CPUs 

multiplied by estimated users per CPU.

GenServer Users Capacity-Variance: General-type application user concurrency 

minus estimated concurrency.

GenServer Required-Servers: Estimated user concurrency divided by the general-type 

server users per CPU.

GenServer Available-Servers: Number of available general servers.

GenServer Server Capacity-Variance: General-type application server concurrency 

minus estimated concurrency.

GenServers Balanced: Indicates whether the CPU and RAM are consistent across 

general-type application servers.

See also: System Security Users and Groups in the OneStream Software Design and 
Reference Guide.

C) Con-DataMgmt Concurrency

Use items in this group to gain insight into the user load on your data management-type or 

consolidation-type application servers.

ConServer Required-Servers: Estimated concurrency divided by estimated users per 

CPU divided by standard application server CPUs, multiplied by General-type application 

server to Consolidation-type application server ratio.

ConServer Available-Servers: Current consolidation servers being used.
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ConServer Capacity-Variance: consolidation servers required minus the available 

consolidation servers. A value of 0.0 means consolidation servers are available. A value 

of 1.0 indicates that consolidation servers are required.

ConServers Balanced: Indicates whether the CPU and RAM are consistent across 

Consolidation-type application servers. A value of 0.0 means the consolidation servers' 

CPU and RAM are consistent across the application servers. A value of 1.0 indicates 

CPU and RAM are not consistent.

DMServers Dedicated: Indicates whether a dedicated Data Management-type 

application server is required.

D) DB-Server Resources

The group reflects the settings for the database server in the AzureSQL Elastic Pool for 

Azure Cloud environments.

DB-Server Resources

AzureSQL Edition-Check (Application): Indicates whether the Azure SQL application 

database runs at a business-critical service level. A value of 1 equals yes. A value of zero 

equals no.

AzureSQL ServiceObjective-Check (Application): Indicates whether the Azure SQL 

application database runs in an Elastic pool. A value of 1 equals yes. A value of zero 

equals no.

AzureSQL Edition-Check (Framework): Indicates whether the Azure SQL application 

framework runs at a business-critical service level. A value of 1 equals yes. A value of 

zero equals no.
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AzureSQL ServiceObjective-Check (Framework): Indicates whether the Azure SQL 

application framework runs in an Elastic pool. A value of 1 equals yes. A value of zero 

equals no.

Environment Statistics Status

Status Description

Informational Data point used in environment statistics calculations.

Ok Indicates that the metric does not affect application performance.

Warning Indicates that the metric may negatively affect application 

performance.

Critical Indicates that the metric is negatively affecting application 

performance.
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Environment Analysis Reports
Click Reports at the top of the page and select the name of the report you want to run.

Database Sizes: Provides insight into the elastic pool usage for Azure customers. 

Databases are sorted into used, unused, or allocated types.

NOTE: For Cloud customers, an elastic pie chart is displayed at the beginning of 

the Database Sizes report.

Memory Manager: Provides the server memory details over the previous 15-day period. 

Any events over 10 days reflect a critical status.

Resource Validation: Provides a detailed breakdown of the General Stage 

Concurrency, Consolidated-Data Management Concurrency, and Database Server 

Resources.

Server Detail: Provides details for the application servers.

Server Startup: Provides the server startup details over the previous 15-day period. Any 

day with zero start ups reflects a critical status.
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Application Analysis
Application Analysis lets you create application snapshots by gathering information 

maintained by the selected application and its database tables. The application analysis 

page displays application metrics, data volume statistics, and reports. It also allows 

administrators to compare snapshots from across system applications.

Create an Application Snapshot
 1. Click New Snapshot to populate an application snapshot.

 2. A pop-up dialog prompts you to enter the Data Volume Year (the year to which the 

data volume statistics apply), Data Volume Detail (the number of top records 

recorded for the data volume statistics), and Snapshot Name. The snapshot name 

defaults to New Snapshot if you leave the snapshot name blank.

The new snapshot displays on the left side of the dashboard panel.

To change the snapshot name, select the name field, change the name, and click . To 
delete a snapshot, select the snapshot name and then click .
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NOTE: You must click the save icon after making any changes, including 

deleting a snapshot, for your environment to update.

Application Metrics
This section shows the application metrics that are considered key stakeholder drivers for 

the general performance of an application. You can click on any row in the Application 

Metrics grid to view additional details of the records in that metric.

Stored Formulas: Applications that have many stored formulas may notice a 

consolidation performance impact. Green Status: Less than 1000, Orange Status: 1000-

2000, Red Status: Higher than 2000.

Dimensions with over 1000 Members: Multiple dimensions greater than 1,000 

members can result in a large and sparse data model which can impact consolidation and 

reporting performance. Green Status: Less than 2, Orange Status: 2-3, Red Status: 

Higher than 3.

Members with Auto-Translate Currencies: Applications that use the Entity Auto 

Translate property will have reduced consolidation performance. Green Status: 0, Orange 

Status: 1-20, Red Status: higher than 20.

Cubes with Non-Standard Consolidation or Translation Algorithms: Applications 

that use non-standard consolidation or translation algorithm types may have reduced 

consolidation performance. Green Status: 0, Orange Status higher than 0. No Red status.

Attribute Members: Applications that have greater than 500 attribute members will have 

a negative impact on consolidation performance. Green Status: 0, Orange Status: 0-500, 

Red Status: higher than 500.
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Number of Stored Records for Largest Data Unit: Data Units larger than 500,000 

records may cause consolidation and reporting performance degradation. Green Status: 

less than 1,000,000. Orange Status: 1,000,000-2,000,000. Red Status: Higher than 

2,000,000.

Number of Stage Records for Largest Workflow: Workflows with more than 1,000,000 

finance load result records may result in reduced stage performance. Green Status: 

1,000,000. Orange Status: 1,000,000-1,500,000. Red Status: higher than 1,500,000.

One to One Entity Relationships: Entity hierarchies with numerous one to one parent 

child relationships can result in poor consolidation performance. Green Status: 0, Orange 

Status: 1-5, Red Status: higher than 5.

Number of Closed Cube Root Workflow Profiles: Closed workflow profiles may cause 

reporting and navigation performance degradation. Green Status: 0, Red Status: greater 

than or equal to 1.

Number of Active Finance Rules and Member Formulas Using BRApis: Finance 

Rules and Member Formulas that use BRApi functions can result in a degradation of 

consolidation performance becaisethese functions need to open a database connection. 

Consider using API function equivalents whenever possible. Green Status: 0, Orange 

Status: 1-10, Red Status: Higher than 10.

Number of Active Finance Rules and Member Formulas without Consolidation 
Conditions: Finance Rules and Member Formulas without consolidation if conditions can 

result in a degradation of consolidation performance because the rule may needlessly run 

at multiple levels of the consolidation dimension. Green Status: 0, Orange Status: 1-10, 

Red Status: Higher than 10.

Number of Active Finance Rules and Member Formulas without Entity Conditions: 

Finance Rules and Member Formulas without entity if conditions can result in a 
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degradation of consolidation performance because the rule may needlessly run for both 

base and parent entities. Green Status: 0, Orange Status: 1-10, Red Status: Higher than 

10.

Number of Active Finance Rules and Member Formulas Using Error Logging: 

Finance Rules and Member Formulas that have active error logging still commented in 

can result in a degradation of consolidation performance because these rules write to the 

error log during a consolidation. Green Status: 0, Red Status: Higher than 0.

Number of Active Finance Rules and Member Formulas that Execute 
Api.Data.Calculate within a For Each Loop: Finance Rules and Member Formulas that 

execute an Api.Data.Calculate within a For Each Loop can result in a degradation of 

consolidation performance due to the inefficiencies of looping through a list of the opening 

of a data unit potentially many times in memory.

Potential Number of Stored Data Cells for Largest Data Unit: Represents the 

maximum number of data cells for this data model.

Application Metrics Status

Status Description

Ok Indicates that the metric does not affect application performance.

Warning Indicates that the metric may negatively affect application 

performance.

Critical Indicates that the metric is negatively affecting application 

performance.
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Data Volume Statistics
This section reflects on the data volume detail of the application based on the year 

selected for the snapshot.

Cube Data Volumes: Reports on the cube, scenario, entity, and year combinations with 

the most data volume rows in the DataRecord database tables.

Stage Data Volumes: Reports on the workflows with the most data rows in the 

stagetofinanceloadresult database table.

Register Data Volumes: Reports on workflows with the most records that are found in 

the installed Register Plan database tables.

BiBlend Data Volumes: Reports on BiBlend data volumes in the 

StageBIBlendInformation database table.

Application Analysis Reports
Application Analysis reports are based on the selected snapshot time period.

Database Table Sizes: Summarizes application table sizes by row count, used space, 

unused space, and allocated space.
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Long Running Formulas: Reports on any long-running formulas logged in the error log 

during the previous 30 days from when the selected snapshot was taken.

OneStream Solution Deployment: Reports on all the deployed OneStream Solutions in 

the current application when the selected snapshot was taken.

Snapshot Summary: Summarizes all the snapshot data found in the application metrics 

and data volume statistics tabs into one PDF report.

Compare Application Snapshots
Click Compare Snapshots to compare any two application snapshot metrics. You can 

compare snapshots in the same application or different applications.

 1. Select a snapshot from the table on the left to be the original snapshot.

 2. Select the application you would like to choose your comparison snapshot from the 

snapshots list grid on the left.

 3. Select the snapshot you would like to compare to the original.
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Auto-created Task in Task Scheduler
When the solution's tables are first set up, a task called System Diagnostics Snapshot 
Automation is created in Task Scheduler. Task Scheduler is only viewable on 

OneStream Desktop. This task runs monthly on the third Saturday of the month at 11:30 

PM UTC. The task takes an environment snapshot and also takes an application 

snapshot for the application where System Diagnostics was deployed.

If other applications in the same environment already have a System Diagnostics solution 

installed, a new System Diagnostics install in another application results in the task being 

scheduled to run 30 minutes before the existing System Diagnostics tasks in the 

environment to ensure environment resources are not exhausted by having several 

application snapshots run at the same time.

See also: Create Tables

Modify the Task
Administrators can modify the Snapshot Automation OSD task to change the frequency 

or scheduled time of the automated snapshot:

 1. Navigate to the Task Scheduler page in OneStream (Application > Tools > Task 
Scheduler).

 2. Select the task called Snapshot Automation OSD and click Edit.

 3. Click the Schedule tab and change the frequency and scheduled time. See the 

Task Scheduler section in the Design and Reference Guide for more information on 

using the Schedule tab.
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Re-create the Task (After Deleting)

If the task gets deleted for any reason, and the administrator wants to re-create the task, 

there are two options.

 l Find the dashboard 0_Frame_OSDS under the dashboard group Solution Setup 
(OSDS) and run it. Then click Setup Tablesto create the task.

 l Manually create a task with the frequency needed and select the 

SnapshotAutomation_OSD sequence. Then set the Data Volume parameter to 

10, as shown below:
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Report Package
The report package function allows you to generate environment and application 

snapshots in the background of the application. These snapshots are created and stored 

in a .zip file that can be emailed to OneStream Software Support for further assistance 

resolving any system issues.

To create a report package:

 1. Click the Report Package button in the upper right corner of the System 

Diagnostics page.

 2. A pop-up message is displayed on the screen to verify that report package will run in 

the background of the application. Click OK and the report will begin to run.

NOTE: If report package is already running and you attempt to click the 

report package button again, a pop-up message is displayed stating that 

there is already a report being generated.
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 3. After completion, the reports are available in the OneStream File Share. The .zip file 

can be located by going to System > File Explorer > File Share > Applications > 

ApplicationName > DataManagement > Export > UserName Folder.

 4. Click on the appropriate .zip file and download the file content using the file 

download button .

 5. The .zip file can then be attached to an email and sent to OneStream Software 

Support.

NOTE: Any errors incurred during the report package creation are listed in 

a .txt file which is available with the snapshot PDFs.
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Task Analysis
The Task Analysis page lets you query the number of tasks running in parallel over a 

given time frame by application, application server, task type, and environment snapshot. 

Use the Task Analysis page to run a daily log-on chart compared to environment 

resources.

The data is represented as a line chart in the Task Analysis page, with each line 

representing a daily logon type. Check boxes at the top of the chart let you exclude log-on 

types.

You can also hover over data points of the lines in the chart to see a count of daily log-ons 

for the highlighted log-on type in a pop-up. Data points occur on each date on the chart as 

defined by the evaluation criteria.

This page also provides access to the Task Concurrency, Task Statistics, and Task 
Counts pages. You can also print these charts by clicking on the printer icon in the top 

right corner of the task analysis page.

Upon clicking the Task Analysis tab, you will see the Daily Logon displayed in a line chart.
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Chart Parameters
All pages available in Task Analysis work the same way. Select criteria in the parameters 

box to the left of the page to determine the data that displays on the chart. Criteria 

includes:

Evaluation Date: Date for which you want evaluation data to start.

Evaluation Days: Number of days before the Evaluation Date to evaluate and include on 

the chart. For example, if you select 2021-07-22 as the Evaluation Date and 15 for the 

number of evaluation days, the chart reflects data from 2021-07-22 to 2021-07-07.

Application: Select the name of the application you want to analyze data from the list. 

Applications in the list are based on your security role.

Task Type: Select a specific task type to evaluate or select the default (All) to include all 

task types.
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Environment Snapshot (Daily Logon and Task Concurrency only): Select the 

snapshot that contains the data you want to use as the source for daily activity charting.

To create a new chart:

 1. Use the fields located in the parameters box to update your chart.

 2. Click RUN > to create the chart based on the defined criteria.

NOTE: After changing parameters, a message is displayed on the screen 

reminding you to click RUN > to refresh the chart.
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Task Concurrency
This page lets you query the number of tasks running in parallel over a given time frame 

by application, application server, task type, and environment snapshot.

Task Concurrency bar chart data is based on the currently selected criteria. Each bar 

represents a day during the evaluation period. Each color in a bar represents either a task 

type defined using the evaluation criteria or a selected log-on type.

Like Daily Logon charting, checkboxes at the top of the chart represent the different daily 

concurrencies being tracked based on the evaluation criteria. Select or clear checkboxes 

to show or hide log-on types in each bar on the chart.
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View Daily Concurrency Details
Click on any bar in the Daily Concurrency chart to view the detail for that day in a separate 

bar chart. The Hourly Activity chart uses a bar to represent each hour increment of the 

day selected in the Daily Concurrency chart. The left axis labels of the chart are for each 

two-hour increment in the day.

Click on any bar on the Hourly Concurrency chart to view the detail for that hour in a 

separate bar chart. The Minutely Activity chart uses a bar to represent each minute 

increment of the hour selected in the Hourly Concurrency chart. The left axis labels of the 

chart are for each four-minute increment in the hour.
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Click on any bar on the Minutely Concurrency chart to view specific log-on detail along 

with any task or error detail for that minute in a separate detail application window.

System Diagnostics Guide 45



System Diagnostics Guide 46



Task Statistics
This page provides the ability to query the minimum, maximum, and average durations in 

seconds by date, application, application server, and task type.

Selecting or clearing Min, Avg, or Max in the statistic key updates the daily task statistics 

chart. Any changes to chart variables or parameters will prompt you to click RUN > to 

refresh the chart.
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Task Counts
This page provides the ability to query the number of tasks completed over a given time 

frame by application, application server, and task type.

Selecting or clearing Complete, Fail, or Cancel in the task key will prompt you to click 

RUN > to refresh the chart. Additionally, any changes made to chart parameters will 

prompt you to refresh the chart.
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Live Monitoring
Live Monitoring provides environment and task health data for a given time period which 

can be changed by system administrators.

NOTE: This function is not available for users using Cloud environments.
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Environment Health
This section provides a way to check the application environment health by different time 

frame durations and intervals.

To help differentiate between environment health live monitoring sessions, the 

description value can be changed by selecting the description field, changing the 

description, and clicking Save.  Sessions can also be deleted by selecting them from the 
list and clicking Delete Row .

Duration: Set the duration to monitor from a range of 1 minute to 12 hours.

Interval (Seconds): Set the interval to monitor from a range of 10 to 600 seconds. The 

first monitoring point will be at the interval time selected with additional point being 

recorded at each interval.

NOTE: Running short intervals over long durations may impact system 

performance. An interval of 60 seconds or greater should be used for longer 

duration monitoring.

Click RUN> to run the environment health monitoring job.
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Select the job by highlighting a row and select from one of the three output methods: 

Analysis, Pivot, or Report.

Analysis
Select Analysis to view the environment health monitoring data in a table with target, 

minimum, average, and maximum indicators. Selecting a metric will display item details to 

the right of the analysis table.

Environment Health Monitoring Status

Status Description

Informational Data point that is used in environment health monitoring 

calculations.

Ok Indicates that the metric does not affect application performance.
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Status Description

Warning Indicates that the metric may negatively affect application 

performance.

Critical Indicates that the metric is negatively affecting application 

performance.

Environment and Task Health Monitoring Status

Status Description

Informational Data point that is used in environment health monitoring 

calculations.

Environment and Task Health Monitoring Groups / 
Items

A) Application Concurrency

Total Logged on Users: Number of users logged on to the environment compared to the 

number of users that the environment can support.

If the number of users logged on to the environment is greater than the supported limit for 

the environment, UI and reporting performance may degrade to the point of requiring an 

IIS Recycle.

Running Task Total: Total concurrent tasks in progress at the time of the monitoring.

Running Tasks Type: Total tasks in progress by the type at the time of the monitoring.
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Running Tasks Server: Total tasks in progress per server at the time of the monitoring.

B) App Server Health Items

Memory in Use: Total memory being used by OneStream processing.

Server Memory in Use: Total memory being used by the application server.

Total Memory: Total memory available on the application server.

Memory Utilization: Amount of memory used for the analytic cache and all other caches.

The reserve memory must be large enough to hold all non-analytic cached items, such as 

metadata, workflow, stage processing. If this value is consistently high and gets above 

90%, reserve memory should be increased because non-analytic memory consumption is 

larger than the reserve and virtual memory pressure grow.

CPU Count: Number of CPUs on the application server.

CPU Utilization: CPU activity for the specified application server as a percentage of 100.

High CPU usage is common for Consolidation, Data Management and Stage servers. 

However, CPU utilization should fluctuate for General Servers (Consistent high CPU 

utilization on General-type application servers indicates that more General server CPUs 

are required).

Server Logged on Users: Number of users logged onto the application server.

If the number of users logged onto the environment is greater than the supported limit for 

the environment, UI and reporting performance may degrade to the point of requiring an 

IIS Recycle.

C) DB Health Items

The following items display for Application and Framework Databases.
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Blocking Transaction Count: Number of transactions that are delayed or stopped from 

processing in the database.

Page Life Expectancy: Average expectancy for how long each data page is staying in a 

buffer cache before being removed to make room for other pages.

A value below 3000 indicates memory pressure (Below 1000 represents extreme memory 

pressure).

Example: A server with 230 GB RAM allocated to the SQL 

Server buffer pool and a Page Life Expectancy of 300 would 

equate roughly to 785MB/sec of I/O activity to maintain the 

page churn inside of the buffer pool. While it might be possible 

for the I/O subsystem to keep up with this demand, this 

represents a significant number of page churn in the buffer 

pool.

Buffer Cache Hit Ratio: Indicates the percentage of pages that were found in the buffer 

pool without having to incur a read from the disk.

The recommended value should be between 95 and 100. A lesser value indicates 

memory pressure.

Memory Grants Pending: Indicates the number of processes waiting on a workspace 

memory grant.

A higher value indicates the server needs more memory.

Total Server Memory (GB): Amount of memory that a server has committed using the 

memory manager.

Target Server Memory (GB): Amount of memory that a server is willing to allocate to the 

buffer pool under its current load. The Target Server Memory value shows how much 

memory the SQL Server needs for the best performance.
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Total-Target Memory Ratio: Total Server Memory / Target Server Memory

When the Total Server Memory and Target Server Memory values are close, there’s no 

memory pressure on the server. The recommended ratio value should be 1.

Total Connection Count: The number of client connections accessing the database.

A high connection count near the target means that the MaxPoolSize of the SQL 

Connection should be increased or connection time-outs may occur.

Total Select Count: Number of select statements executed during the monitor period.

Total Insert Count: Number of insert statements executed during the monitor period.

Total Update Count: Number of update statements executed during the monitor period.

Total Delete Count: Number of delete statements executed during the monitor period.

Lazy writes/sec: Indicates the number of times per second the server relocates dirty 

pages from buffer pool to disk.

The recommended value for Lazy Writes/Sec is below 20.  Higher paging and disk I/O 

activity indicate insufficient memory. Check Page Life Expectancy and if its value is low 

(below 1000 seconds), then this is a clear indication of memory pressure.

Page reads/sec: Indicates the number of physical database page reads that are issued 

per second. This statistic displays the total number of physical page reads across all 

databases.

The recommended Page Reads/Sec value should be under 90. Higher values indicate 

insufficient memory and indexing issues.

Page writes/sec: Indicates the number of physical database page writes that are issued 

per second.

The recommended value for Page Writes/Sec is below 90. Higher paging and disk I/O 

activity indicate insufficient memory.
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Pivot
Select Pivot to view the environment health monitoring data in a table by the number of 

interval evaluations that were selected.

Reports
Select Reports to view the environment health monitoring analysis and detail.

Environment Health Analysis: Provides the Environment Analysis for the application 

and database servers.

Environment Health Analysis (With Explanations): Provides the Environment 

Analysis for the application and database servers with explanations.

Environment Health Detail: Provides the Environment Detail for the application and 

database servers.
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Task Health
This section provides a way to check the task health by different task types, durations, 

intervals, and evaluations. If there are no unhealthy tasks for a selected snapshot, no data 

will populate on the Analysis, Pivot, and Reports tabs.

Task Type: Set the type of task to monitor.

Duration: Set the duration to monitor tasks from a range of 1 minute to 12 hours.

Interval (Seconds): Set the interval to monitor tasks from a range of 10 to 600 seconds.

Seconds Before Flag: Set the Seconds Before Flag to capture tasks that have been 

processing for more than a 10 to 6000 second runtime.
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Evaluation Before Log: Set from a range of 1 to 10 to determine the number of times to 

skip logging the task if the task has exceeded the seconds before flag.

Click RUN > to begin the task health monitoring job.

Select the job by highlighting a row and select from one of the three output methods: 

Analysis, Pivot, or Report.

Reports
Select Reports to view the task health monitoring analysis and detail.

Task Health Analysis: Provides the Environment Analysis for the application and 

database servers.

Task Health Analysis (With Explanations): Provides the Environment Detail for the 

application and database servers.

Task Health Detail: Provides the Environment Detail for the application and database 

servers.

Unhealthy Tasks
This section will reflect any tasks that are not processing successfully for a given 

monitoring time frame.
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Help and Miscellaneous Information

This page contains solution documentation.

Display Settings
OneStream Platform and Solutions frequently require the display of multiple data 

elements for proper data entry and analysis. Therefore, the recommended screen 

resolution is a minimum of 1920 x 1080 for optimal rendering of forms and reports.

Additionally, OneStream recommends that you adjust the Windows System Display text 

setting to 100% and do not apply any custom scaling options.

Package Contents and Naming Conventions
The package file name contains multiple identifiers that correspond with the platform. 

Renaming any of the elements contained in a package is discouraged in order to preserve 

the integrity of the naming conventions.

Example Package Name: OSD_PV8.0.0_SV100_PackageContents.zip

Identifier Description

OSD Solution ID

PV8.0.0 Minimum Platform version required to run solution

System Diagnostics Guide 60

Help and Miscellaneous Information



Identifier Description

SV100 Solution version

PackageContents File name
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Solution Database Migration Advice
A development OneStream application is the safest method for building out a solution 

with custom tables such as this one. The relationship between OneStream objects such 

as workflow profiles and custom solution tables is that they point to the underlying 

identifier numbers and not the object names as seen in the user interface. Prior to the 

solution configuration and to ensure the identifiers match within the development and 

production applications, the development application should be a recent copy of the 

production application. Once the development application is created, install the solution 

and begin design. The following process below will help migrate the solution tables 

properly.

See also: Managing a OneStream Environment in the Design and Reference Guide.
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OneStream Solution Modification 
Considerations
A few cautions and considerations regarding the modification of OneStream Solutions:

 l Major changes to business rules or custom tables within a OneStream Solution will 

not be supported through normal channels as the resulting solution is significantly 

different from the core solution.

 l If changes are made to any dashboard object or business rule, consider renaming it 

or copying it to a new object first. This is important because if there is an upgrade to 

the OneStream Solution in the future and the customer applies the upgrade, this will 

overlay and wipe out the changes. This also applies when updating any of the 

standard reports and dashboards.

 l If modifications are made to a OneStream Solution, upgrading to later versions will 

be more complex depending on the degree of customization. Simple changes such 

as changing a logo or colors on a dashboard do not impact upgrades significantly. 

Making changes to the custom database tables and business rules, which should 

be avoided, will make an upgrade even more complicated.
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